Your Introductory Lab will guide you through the steps necessary to utilize state-of-the-art technology to acquire and graph data of mechanics experiments. Throughout Visual Physics, you will be using a high-definition camera to acquire video images of phenomena, select and digitize the location of points on each image in a time sequence using data-acquisition software, and transfer the time and position information to a spreadsheet for analysis of physical phenomena.

In each laboratory session, you will be addressing several Problems. Each Problem is posed in a fashion much as it might arise in your professional life. There is a method by which we approach problems in science. You first try to define the problem in terms of physical quantities that you can measure. Then you try to use the physics that you know (or are learning!) to make predictions about how the physical quantities should behave in the situation of the Problem.

Now you are ready to plan an experiment to test your predictions. In this course, we have provided you with a technical system that can be used to capture a video image of the Problem situation. The video image will consist of a time sequence of still frames, recorded in a succession of equal time steps. This will be referred to as a movie. You will need to learn how to adjust the position of the video camera to optimize the image for each Problem situation. You will also need to plan the point or points in each still frame for which you will want to digitize the location, and devise a means to recognize that precise point in each frame.

You will be able to analyze the frames of a video image using the award-winning software LoggerPro 3.6, a software environment for data acquisition and control. You do not need to possess previous experience with LoggerPro 3.6, as you will familiarize yourself with this powerful application in this Introductory lab. LoggerPro is a powerful data acquisition and control environment that is widely used in experimental and classroom science and engineering. If you wish to learn how to use LoggerPro on your own, the Texas A&M University software license with the LoggerPro software vendor Vernier allows students to install LoggerPro on their own personal computers. If you are interested in installing a copy on your own pc, please bring in your own blank compact disc (cd) and ask your Visual Physics Teaching Assistant (TA) to burn a copy for you on your cd.

Once you have recorded a movie, you will select the target points and digitize them. Each time you cursor-select a target point, its position coordinate and velocity will be displayed in a spreadsheet along with the time of that frame, where the time is the number of frames since the video sequence began. Part of your task is to devise a procedure to calibrate the location and time, and convert it into the physical space and time of your experiment. This short introductory laboratory is designed to familiarize you with all the steps required to accomplish this.

This lab is designed to familiarize the student with the camera and computer software only. There are no questions to answer or a Technical Memo to submit.

**NOTE: During the experiments in which a marble launcher is used, all students in the lab room are required to wear safety glasses at all times. Failure to wear safety glasses will mean expulsion from the lab and a grade of zero (with no makeup available). Safety glasses are available at the front TA desk.**
Procedure

The camera is an Aiptek High-Definition A-HD+ camcorder. It can record videos onto a memory card in a Quicktime movie format at a resolution of 1440x1080P (4:3 aspect ratio) or 1280x720P (16:9 aspect ratio). You will copy your movies from the memory card to the computer. You will then open LoggerPro and collect data points and save the data in a text file. Execute the following steps:

1. Mount the camera between the fingers of the clamp that is attached to the long steel rod on a heavy steel base as shown in Figure 1. Be sure the camera is secure on the clamp but not so tight that it will crack the housing of the camera. Note that the screen of the camera is to one side such that you can view the images through the lens. The base that holds the steel rod is heavy so be careful that it is on a flat surface and do not drop it. Do not get on top of a chair or lab table to adjust the camera (safety issue). You should be able to do all the pre-adjustments on the finger clamp and rod before setting the camera out of reach. Most of the time you should be able to mount the camera such that it can be reached for adjustment.

2. Open the LCD window to power on the Aiptek camera. Make sure the focus switch on the side of the camera is all the way up. Set the marble launcher at the opposite end of the table (away from the computer monitor) as shown in Figure 2. The launcher should be slid slightly under the shelf on the table top. The marble’s plane of motion will be perpendicular to the line of sight of the camera. Place a poster board and a meter stick beside the launcher. You will use this meter stick to set the scale in a later step. Ensure that the poster board is stable on the desktop and will not fall (one of the lab partners may hold it up). Set the camera zoom such that most of the marble’s parabolic trajectory is captured in the video frame, but especially the initial point of flight. Rotate the camera and marble launcher as necessary, but keep them perpendicular. The marble launcher has different power settings, though we will only use the upper three notches in the lab (the ball should not fly into the next lab table). Pick one of the three notches (# 1,2,3), then do a few test
shots to ensure the camera is focused and zoomed properly. [ CAREFUL – DO NOT PUT YOUR FACE NEAR THE OPENING OF THE LAUNCHER TUBE AT ANY TIME. REMINDER – keep your safety goggles on at all times. ] Now press the record button before you set the marble in flight.

3. Now you are going to record a cart as it moves along the frictionless air track. Turn on the air blower. See Figure 3. Set the air blower power setting to maximum.

4. Place the cart on the air track and position the camera directly over the air track. Set the camera zoom and ensure that it has auto-focused. Verify the air track is level by placing a cart at the center and leveling the legs of the track until the cart does not move. Now set the cart in motion and capture it to video. You are now finished recording all your videos.

5. You will now copy your movies from the memory card to the computer. Remove the memory card from the camera and insert the card into the card slot on the side of the monitor.
6. Double-click on the LoggerPro icon on the desktop to start LoggerPro. From the *Insert* drop-down menu, select *Movie* and then browse to the memory card. This screen is shown in Figure 4. Select the movie you want to open. First select the marble launcher movie. This will open up the movie in a LoggerPro sheet. The screen you will see is shown in Figure 5. You will first need to set the scale and insert coordinate axes in LoggerPro. Click the button in the lower right corner of the movie window with the three red dots on it. This will display a tool bar on the right-hand-side of the window. To set the scale, click the 4th button down from the top of the tool bar with the yellow horizontal ruler. This will allow you to set the scale of the movie to an actual dimension. Pick one point on the meter stick, then while holding the left mouse button down, drag the green...
line to another point on the meter stick. In the dialog box, enter the actual distance between the two points you selected in meters or centimeters. **It is important that you remember that all your data from this point forward from this video will be in the units you just set the scale with, either in meters or centimeters.** Next, click the third button down on the tool bar, which is **Set Origin**, and click the left mouse button and while holding the left mouse button down, drag the mouse to the location where you want to locate the origin of your coordinate axes. You should see a yellow set of x and y axes. On the x-axis notice there is a small yellow circle. This is used to rotate the axes and recalculate all your data points. This will be a very useful feature as we go along this semester. Try it out and rotate the axes.

7. You are now ready to collect data. The movie player buttons (at the bottom left of the window) control the movie. With these you can advance the movie frame by frame and select points in each frame. The toggle lever just above these buttons can also be used to move to the desired portion of the movie by holding down the left mouse button and moving the lever. You are now going to collect data of the flight of the marble. Advance the movie until the marble has just left the marble launcher. To add a data point, click the second button from the top of the tool bar, **Add Data Point**. Place the cursor over the marble and click on the marble. After you click the first data point, the movie will advance one frame. Then click the marble again. The movie will advance one frame forward again. Notice that the time, position, and velocity data is shown in a spreadsheet on the left side of the screen. The time is the actual time of the frame in the movie, and the position data are the actual (x,y) coordinates in the units you chose for the position of the axes. The x and y velocity data is calculated for you as well. Collect enough data points to follow the flight of the marble, at least 10 data points. Move the movie window and resize the spreadsheet window so that you can view all the data columns. The movie window can be moved by placing the cursor over the top of the movie window until the cursor turns into a hand. Grab the movie window and move it so that you can resize the
8. Once you have collected all the data points off the movie, it is time to save the data into a text file. First you need to create a folder on your computer to save all your text files to and any movies you may want to save onto the computer, if this has not already been done. Click the 218 Labs icon on the desktop, and if there is no folder created for your section, create one now. To save your data as a text file, select the File drop-down menu and select Export As, and select Text. See Figure 7. Name the file and save it into your section folder under the 218 Labs folder. As you perform the experiments this semester, you will have to name the files so as to simplify keeping track of which experiments they are for.

9. The last step is to plot the data in an application such as Excel. Most of the time you will do this outside of lab, but here are a few guidelines to follow. If you are not familiar with Excel spreadsheets and plotting data, then you must take some time in the first few weeks of the semester and familiarize yourself with the program. The file you have saved is a ‘delimited’ text file. Delimited means the numbers are separated by a character, such as a space, tab, or comma. This is how Excel distinguishes between different numbers in the text file. Double-click the Excel icon on the desktop, then click the round Office Button on the top left of the screen and click Open, then navigate to your section folder where the text file is saved. Make sure in the Files of type: bar at the bottom of the dialog box Text Files or All Files is selected. Select the text file and you will see the Text Import Wizard dialog box. Make sure Delimited is selected and click Next. Verify Tab is selected, then click Next, and then Finish. You will now see your data from LoggerPro in an Excel spreadsheet. There are many features and tools available in Excel for plotting your data, but today you will just complete a basic plot. To display a chart, select the Insert tab at the top of the window, then select Scatter Chart, then select the first chart type Scatter with only Markers. See Figure 8. This will display an empty chart. Place the cursor over the chart and click the right mouse button, and then
click Select Data… This opens the Select Data Source dialog box. Click the Add button to add the data series. To add the data series for the Y-axis, click the small button at the right end of the Series Y values: bar. This brings up the Edit Series bar. Highlight the column of data that you want to be the parameter for the Y-axis. Let’s choose the Y data. Highlight only the numbers and not the text in that column. You should see a blinking border around the data you have selected. Click the small button on the right end of the Edit Series bar. Next click the small button on the right end of the Series X values: bar. Highlight the Time column, numbers only, and then click the small button in the Edit Series bar again. If you want to label the data series you just plotted, type a name in the Series name: bar, then click OK. Click OK again. This is shown in Figure 9. You now have a line chart with markers at each data point with the Y position on the vertical axis and the Time on the horizontal axis. You will later learn this semester that the slope of this line is the Y-Velocity. To give the chart axes labels, the chart a title, as well as change the color and other attributes of the chart, click the Layout tab at the top of the screen and you will see all the options available. Your final chart should look like Figure 10. You will be plotting many different parameters this semester, so it is important that you learn how to place ANY column of data from your spreadsheet on the vertical axis, and ANY column of data from your spreadsheet on the horizontal axis. In addition, this semester you will also have to plot parameters such as mass and period, which will not be in your data file. To plot these on either the X-axis or Y-axis, you will have to enter these values into a new column in your spreadsheet, then plot that column as you just did.
10. Repeat steps 5. through 8. for your movie of the cart in motion on the frictionless air track. To select the data points, click the same point on the cart in each frame of the movie. This will ensure accurate velocity and acceleration data is obtained. Figure 11 shows what your LoggerPro screen will look like if you click each data point at the front of the cart every 10 frames. In Figure 11, the axes have been rotated slightly to align with the air track, hence you will only have a position change in $x$. 
Figure 12 shows one possible chart of the air track data. In this chart, the X-Velocity has been plotted versus Time. You will learn this semester that the slope of this line is the X-

Acceleration. You notice that in this plot the X-Velocity is in a very narrow range. The air track is frictionless, so the velocity should be constant, however, the exact same point on
the cart cannot be selected every time in LoggerPro, so this will always be a source of error.

Once all members of the lab group feel confident they are prepared to use the lab equipment and software for Lab 1, you are completed with Lab 0. Lab 1 is a lengthy lab, so work as long as necessary with the camera and software today so that you are fully prepared to execute all the steps in Lab 1. Note – there is no lab report to submit for this lab.

EQUIPMENT LIST FOR LAB 0:

- Goggles
- Camera (memory card and AC charger)
- Heavy duty stand with finger clamp
- Air track and cart
- Launcher and marble
- White poster board
- Meter stick

THINGS TO DO AT THE END OF THE LAB SESSION:

1. Replace the heavy stand, rod, clamp on the shelf of the lab table.
2. Replace the camera (with the LCD view finder window closed) on the shelf of the lab table.
3. The meter stick should be put on the shelf of the lab table.
4. The memory card should be left in the slot in the computer monitor.
5. The cart should be left on the air track.
6. Leave the launcher (with the ball in it) and the poster board on the table.
7. Put your safety goggles back in the box at the front TA table.